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0 Hilfsmittel

0.1 SimulIDE

Das kostenlose Elektronik-Simulationsprogramm SimullDE finden Sie in ILIAS unter (DE/EN)

Software.
Alternativ ist das Programm auch Uber die Hersteller-Seite, herunterladbar. Dort muss dann ein

“Obulus” angegeben werden, welcher auch 0€ sein kann.

Im Gegensatz zu TINA Tl hat SimullDE einen anderen Fokus und damit folgende Vor- und Nachteile.

Vorteile:

e Microcontroller wird gut simuliert (u.a. von Atmel Chips). Das ist in TINA TI nicht méglich.
e Die Microcontroller sind auch programmierbar. D.h. man kann Microcontroller-geeignete Source-

File (hex-File) nutzen.
e Interaktion Software und Hardware ist maglich.

Nachteile:

e Simulation von verschiedenen Elektronikkomponenten nur vereinfacht implementiert (z.B.
Operationsverstarker oder FETSs)

¢ Die Software wird noch sehr stark weiterentwickelt. D.h. es ist gut die oben angegebene Version
zu nutzen, um Kompatibilitatsprobleme zu vermeiden.

Zur EinfUhrung in SimullDE hilft es die Playlist des Entwicklers anzusehen.

Tipps fur die Verwendung von Simulide - Konfiguration

{} @_ EII- ﬁ é é @ Speed: D00.00 %

Time: 00:00:00 5 000 ms Q00 ps 000 ns 000 ps

=) Settings ? x

App Circuit Simulation

App Settings Help
Language English -
Font Scale 1.00 =

Fig. 1: Bild zur Konfiguration

MEXLE Wiki - https://wiki.mexle.org/


https://ilias.hs-heilbronn.de/ilias.php?baseClass=ilrepositorygui&ref_id=22088
https://simulide.com/p/downloads/
https://en.wikipedia.org/wiki/Intel_HEX
https://www.youtube.com/watch?v=rwbQDoZ-9hQ&list=PL0YDA67EjDEE5hxtdwSvjL6qtLtfyK39W&ab_channel=SimulIDE

2026/04/08 23:08 3/10 0 Hilfsmittel

* Falls der Text nach dem Offnen des Programms zu klein dargestellt wird, kann eines der

folgenden Vorgehen helfen:

o Im Programm SimullDE nach dem Offnen auf das Zahnrad klicken. Den Reiter App
auswahlen. Dort bei Font Scale beispielsweise 2,0 eintragen und das Programm neu
starten.

o Im Explorer rechtsklick » Eigenschaften » Kompatibilitat » Hohe DPI
Einstellungen andern » Hohe DPI-Skalierung Uberschreiben » Hakchen
setzen » “System” auswahlen. (ggf. “System (Erweitert)” wahlen)

0.2 Microchip Studio

Microchip Studio ist eine Programmierumgebung, um aus C oder C++ ein Microcontroller-geeignetes
Source-File (hex-File) zu erstellen.

Installation

Installationsanleitung

Die aktuelle Version des Programms finden Sie auf der Microchip-Homepage.

1.

Falls nach dem Drucken des Buttons Download Microchip Studio nichts passiert: einfach
herunterscrollen zu Downloads and Documents

Bei schnellen Internetverbindungen kann der Web Installer gewahlt werden, bei langsamen
lasst sich mit dem Offline Installer das gesamte Paket vor der Installation herunterladen.

Bei der Installation ist als Architektur nur “AVR” notwendig.

“Advanced Software Framework and Example Projects” sind nicht notwendig

Die Installation dauert je nach Geschwindigkeit des Rechners und der Internetverbindung etwa
5 Minuten

Falls nicht schon installiert, wird bei der Installation auch Visual Studio mit installiert

Die Frage nach Lizenzen fur den C compiler ist mit Next > zu Uberspringen

Weiterhin kann es sein, dass verschiedene Gerate-Treiber mit installiert werden. Diese
ermoglichen das Beschreiben der Chips mit einem Programmiergerat.

. Offnen Sie im Anschluss direkt Microchip Studio, damit Sie die ersten, wichtigen Einstellungen

vornehmen konnen.

fur Mac-User

Speziell fir Mac User bietet sich folgendes Vorgehen an:

1.
2.
3.

Offnen Sie einen Browser.

Stellen Sie eine VPN Verbindung tUber eduVPN her.

Gehen Sie auf fernzugriff-pools.hhn.hs-heilbronn.de}} - Loggen Sie sich ein und wahlen Sie
einen Rechner aus. - Wahlen Sie das Image von Herrn Ziegler mit "uC_PCB" (Suche nach
Ziegler) - Dann dauert es etwas, da der Pool Rechner nun das Windows-Image startet. - Nun
konnen Sie Uber Ihen Browser auf einen PC mit Microchip Studio zugreifen. - Beachten Sie, dass
alle Daten nach dem Beenden der Session geldscht sind. \\ D.h. es bietet sich an das "U:"
Laufwerk einzurichten. Kommen Sie dazu auf Herrn Ziegler zu. ===== Erster Test der
Verbindung zum AVR-USB-Progi ===== Fuhren Sie folgende Schritte durch, um einen ersten
Test mit der Hardware durchzufuhren. - Vorbereitungen - Verbinden Sie das MiniMEXLE - mit
dem Proggi (schwarze Box) per Flachbandkabel - mit der Steckdose per Ladekabel mit dem
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Hohlstecker - Offnen Sie Microchip Studio (z.B. durch Druck auf die <WIN> Taste und Eingabe
von Microchip Studio, sowie druck auf <Return>). - Laden Sie die Datei
{{microcontrollertechnik:5._menufuehrung.hex}} herunter. - Verbinden Sie nach dem Offnen
das Progi per USB-Kabel mit dem PC / Laptop. Dieser Schritt muss vor den folgenden
geschehen! - Es sollte am Progi die Grune LED fur die USB-Kommunikation leuchten. - USB-
Verbindung eintragen - Gehen Sie ohne Erstellen eines Projekts, direkt auf '"Tools >> Add
Target..". - Im dargestellten Fenster sollten Sie beim bisher leer angezeigten Dropdown-Menu
als Tool "STK500" auswahlen. - Bei der Auswahl des "Serial Ports" sollten Sie den ersten
verfugbaren auswahlen z.B. "COM3" und bestatigen Sie die Auswahl mit "Apply". \\ Sollte hier
keine Port angezeigt werden, prufen Sie, ob die Verbindung mit dem USB-Progi erfolgreich war.
\\ Falls die grine LED leuchtet und das USB Kabel korrekt eingesteckt ist, gehen Sie zu den
Hinweisen unter 4.d. - Erster Verbindungsversuch - Wahlen Sie im MenU ""Tools >> Device
Programming' aus. - Wahlen Sie bei Tools die entsprechende USB-Verbindung aus, z.B.
"STK500 COM3". - Bei Device missen Sie "ATmega88" auswahlen, Sie kénnen dazu ''88"
eingeben und im Dropdownmenu dann den korrekten Wert anklicken. - Beim Interface sollte
nun ISP stehen - Drucken Sie nun auf "Apply". - Im Fehlerfall: - Falls es nach Druck auf "Apply"
langer dauert, hat die Verbindung nicht geklappt. Es wird dann eine Fehlermeldung "Unable to
connect tool STK500 (COMx)" angezeigt. - Die Fehlermeldung kdnnen Sie quittieren, jedoch
dauert es danach nochmals einige Sekunden, bis das Programm wieder korrekt reagiert. -
SchlieBen Sie dann das Fenster ""Device Programming". Gehen Sie in dieser Anleitung zurlck zu
Punkt 2. und versuchen Sie den nachsten Serial Port. \\ Merken Sie sich dabei die Nummer des
Ports, da diese unter 3.b. bendtigt wird. - Wenn alle vorhandenen COM-Ports durchgetestet
wurden, oder zu Beginn keiner angezeigt wurde, kann die Installation eines Virtual COM Port
Drivers helfen. Einen solchen finden Sie unter [[https://ftdichip.com/drivers/vcp-drivers/|FTDI.

4. Im Gutfall:

1. Es sollte nun etwas mehr im Fenster Device Programming sichtbar worden sein.

2. SchlieBen Sie vor den nachsten Schritten das MiniMEXLE (= Platine mit Display und
Kndpfen) mit dem Flachbandkabel an das Progi und mit dem Hohlstecker an das Netzteil
an. Stecken Sie das Netzteil auch in eine Steckdose
Drucken Sie nun auf Read oben neben Device Signature.

4. Es sollte eine hexadezimale Zahl 0x.... erscheinen. Ihr Rechner kann nun fir das Flashen
eine Verbindung zum MiniMEXLE herstellen.

5. Gehen Sie auf im Fenster Device Programming auf den Punkt Memories. Flgen Sie
unter dem Punkt Flash den Pfad zur heruntergeladenen Datei 5. menufuehrung.hex
ein. Sie kénnen dazu auch uber die .. rechts daneben den Pfad auswahlen

6. Drucken Sie auf Program

7. Auf dem Minimexle sollte nun eine Anzeige
- Experiment 5 -

Programm Menu
und dann
Main Level
P1 P2 P3 P4
erscheinen
8. Damit haben Sie die Verbindung und das Flashen erfolgreich getestet

w

wichtige Einstellungen

e Nutzen Sie die Anzeige von Zeilennummern: Tools » Options » Text Editor » All
languages » General » Line numbers

e Sobald Sie das erste Projekt bearbeiten: Deaktivieren Sie unbedingt die Compiler Optimierung.
Dies geht mit folgenden Schritten:
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o Menu Project » <ProjectName> Properties.. » AVR/GNU Compiler »
Optimization
o Das Optimization level sollte hier auf None (-00) stehen
¢ |ch empfehle ATMLE Studio in der Sprache “English” zu nutzen. Damit sind die Hinweise in
diesem Kurs korrekt zu finden. Falls Sie versehentlich (z.B. bei der Installation) die deutsche
Sprache eingestellt hatten, kdnnen Sie es unter Werkzeuge » Optionen » environment »
international settings » Language korrigieren.

Tipps

e Falls auf der rechten Seite der Solution Explorer (Anzeige der Dateien im Projekt) nicht
vorhanden ist, so finden Sie diesen unter
View » Solution Explorer (<CTL>+<ALT>+<L>)

Haufige Fehler

* F_CPU not defined for (z.B. <util/delay.h>) Das beste ist die Frequenz F_CPU im AVR Studio
direkt anzugeben:

o Gehe zu Menu: Projekt » (ProjektName) Eigenschaften » Toolchain »
AVR/GNU C Compiler » Symbols
o Fuge F_CPU=8000000 (bzw. Passende Frequenz) ein

¢ Das Programm kompiliert nicht TWSR not found : Falls Sie einen modernen AVR Chip
nutzen (z.B. 328PB) so kann dieser mehrere SPI und 12C Schnittstellen haben. Damit haben sich
bei diesem Target auch die Register- und Interruptvektornamen geandert. Statt TWSR ist dann
TWSRO oder TSWR1 zu verwenden - je nach gewunschtem Pin. Dies ist am einfachsten Uber
defines der fehlerhaften Namen, also #define TWSR TWSRO usw.

e Beim Flashen der realen Hardware iiber Tools » Device Programming finde ich im
Tool nur “Simulation”, aber kein STK500. Versuchen Sie zunachst Uber Tools » Add
tagret... STK500 und den entsprechenden Serial Port zu wahlen. Falls Ihr Rechner mehrere USB
Ausgange hat, mussen Sie diese (COM1...COMx) beim Programmieren ausprobieren.

* Beim Flashen der realen Hardware erhalte ich “Erasing device failed”, “Error status
received: Got 0xc9, expected 0x00 (An unknown command was sent)“.

o Steht bei Device Programming das Interface auf ISP? Falls nicht kann dies die Ursache
sein. Das Programming geschieht immer mittels ISP.

o Hat das USB-Kabel/Progi/Adapterplatine/Kabel ein Problem? Probieren Sie eine andere
Variante der Komponenten durch

e Mein Chip hat keinen Speicherplatz mehr bzw Ich erhalte ein ‘"Memory Overflow'
Fehler Falls Sie Daten statt im SRAM im EEPROM speichern wollen, so konnen Sie das
Befehlswort “PROGMEM” nutzen. Details dazu finden Sie z.B. auf der Seite von Microchip

e Mein Programm scheint irgendwo nicht weiter zu kommen. Dies kann verschiedene
Grunde haben:

o Endlosschleife

o Speichertberlauf im RAM: sobald die Speicherauslastung des RAM Uber ca 75% steigt,
sind Probleme wie spontane Resets bei Bearbeiten von Pointern, Arrays, Strings oder
Structs wahrscheinlich. Die kann Uber Debugging herausgefunden werden (entweder mit
Steppen mit Debugger oder Ausgabe von Werten nach jeder Zeile).

MEXLE Wiki - https://wiki.mexle.org/
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12C

e Auf den I12C Leitungen andert sich nichts, obwohl der IC etwas ausgeben sollte:

1. Uberpriifen Sie die Pullup-Widerstdnde: Sind welche verbaut? Welche GréBe haben diese?
(typisch: 10kOhm). Wenn keine Verbaut sind, so wechselt das Signal nur zwischen 0V
niederohmig und OV hochohmig. Dies ist am Oszilloskop nicht zu unterscheiden.

2. Ist ein hochohmiger Widerstand $R_L$ entlang der Leitungen verbaut? Falls ja erzeugt
dieser einen Spannungsteiler mit dem Pullup-Widerstand. Wenn $R_L$ grof ist, so liegt
zwischen $R_L$ und Pull-up fast die Versorgungsspannung an.

e Der Master soll Daten vom Slave empfangen, aber hangt sich manchmal auf Im
“Master Receiver Mode” muss der Master das Ende der Kommunikation dem Slave mitteilen.
Dazu muss beim Lesen der Daten TWEA = 0 gesetzt werden. Ansonsten kann es sein, dass der
Slave meint er musse noch Daten senden. Das kann unter Umstanden dazu fuhren, dass der
Slave die Datenleitung SDA am Ende der Kommunikation auf Low legt und damit den I12C stort.

0.3 MEXLE GitLab

Installation der Software auf lhrem Rechner

1. Laden Sie Git von folgender Seiter herunter: https://git-scm.com/download/win » “Standalone
Installer”

Git bietet die Méglichkeit mit dem GitLab Server der Hochschule oder mit GitHub in Kontakt zu
treten

2. Installieren Sie das Git (alle mit “Ok” bzw “Weiter” bestatigen)

3. Laden Sie TortoiseGit von folgender Seite herunter: https://tortoisegit.org/download/
totroiseGit bindet den Explorer direkt an die Services des Git an. Damit ist Git direkt in den
Explorer eingebunden.

4. Installieren Sie das TortoiseGit (alle Hinweise mit “Ok” bestatigen)

Anmeldung beim MEXLE GitLab

1. Melden Sie sich bei GitLab mit den Hochschul-Credentials an: https://git.mexle.org/
2. Gehen Sie zu User settings » Preferences » Password:
z.B. Uber folgenden Link: https://git. mexle.org/-/user_settings/password/edit

SIT ﬂ:]
n 33 =
Q, Search or go to...

Vmiir wimrels

3. Geben Sie ein Passwort mit mindestens 16 Zeichen ein und merken Sie sich dieses Passwort.
Dieses Passwort ermoglicht die Authentifizierung auf GitLab.
Bitte nutzen Sie ein neues Passwort!

MEXLE Wiki - https://wiki.mexle.org/
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Installation der Software auf lhrem Rechner

Die Abfolge ist wie folgt:

1. Erst mUssen Sie sich in GitLab anmelden
2. Dann mussen Sie einem Betreuer per Mail bescheid geben (Prof. Fischer, Ralf

Ziegler) , damit dieser Sie zum Projekt zuordnet
3. Erst dann sind einem Projekt zugewiesen und konnen die folgenden Punkte
durchfthren.

1. Gehen Sie in den (Windows) Explorer und legen Sie einen neuen Ordner fur die Vorlesung an,
z.B. Mikrocontroller oder Elektronik Labor

2. Klicken Sie mit der rechten Maustaste auf den Ordner, um in das Kontextment zu kommen.
Wéblen Sie dort Git Clone.. aus.

I@-’] Git Clone...
| T Gt Create repository here..,
42 TortoiseGit >
ln Dilabimdbnle ool e ™

3. Im erscheinenden GitClone Fenster sollten Sie Folgendes eingeben:
1. als URL: https://git.mexle.org/[Fach]/[Semester].git
also z.B. https://git.mexle.org/mikrocontroller/26ss.git oder
https://git.mexle.org/elektronik/26ss.git flir das Sommersemester 2026
2. als Directory sollte der ausgewahlte Ordner eingetragen sein
3. Klicken Sie nun auf Ok

Flee g LacA ) EILM LI

#" Git clone - TortoiseGit x

Clone Existing Repository

LURL: ns:/fgit.mexle.org/mikrocontroller/2dws. git Browse... -
[] Depth 1 []Recursive [] Clone into Bare Repo Mo Checkout
[]Branch [ ] Origin Mame

[JLoad Putty Key ehreh\31. Mikrocontrollertechnik\GIT 55H private Key.ppk

From SVN Repository
[]From SVN Repository
trunk Tags: tags Branch: branches

Trunk:

From: 0 Username:

4. Im Anschluss sollten Sie eine Fehlermeldung erhalten, da noch das Passwort fehlt.

MEXLE Wiki - https://wiki.mexle.org/
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Hier ist nun das vorher gewahlte Passwort einzugeben.
Dies mlssen Sie auch nur einmalig machen.
5. Der Download sollte nun klappen und es sollten alle Ordner heruntergeladen werden

Upload / Commit von Dateien

Das Hochladen und Andern von Dateien bei Git wird als “Commit” bezeichnet. Diese Nomenklatur
wird auch im Folgenden genutzt.

Im Folgenden wird ein Upload beschrieben; Uber einen Commit kdnnen aber auch Dateien geloscht
werden.

1. Rechtskllck auf den Ubergeordneten Ordner » Git Commlt -> “main”

7 Git Sync...
@ Git Commit -=> "main"...
2 TortoiseGit h

In Riklinthel anfrerhmen
2. Falls eine Fehlermeldung erscheint, siehe nachstes Kapltel

3. Im folgenden Fenster ist nun einiges einzutragen:
1. Tragen Sie unbedingt einen Text unter Message ein, ansonsten ist kein Upload mdglich!
Schreiben sie einen Text, welcher die Anderungen beschreibt.
2. Im unteren Teil sind die zu andernden Dateien zu markieren.
Entweder Sie wahlen die Dateien einzeln aus, oder Sie wahlen z.B. Al1.
3. Zum Commit an den Server wahlen Sie am Button unten v aus und dort Commit & Push

MEXLE Wiki - https://wiki.mexle.org/
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" DAGitLab\mikrocontreller\2dws - Commit - TortoiseGit — O >
Committo:  main [ ] new branch
Message:
n
7ol

[] Amend Last Commit
[] set author date

[] set author

TimFischer <tim . fischer@hs-heilbron:

Changes made (F5: refresh, double-click on file for diff):

Add Signed-off-by

Check:

All Mone Unversioned

Files

Path

L4

Llot Yersioned Files

[ || text.bet

>

[ Staging support (EXPERIMEMNTAL)
Show Unversioned Files

[] Do not autoselect submodules

Show Whole Project

[] Message only

Commit & Push

Commit

ReCommit

1 files zelected, 1 files total

Cancel

View Patch> =

Help

Commit & Push

4. Bestatigen Sie nun den Commit Uber Druck auf den Button Commit & Push
4. Uberpriifen Sie, ob der Commit erfolgreich war durch einen Blick auf die Homepage des

Projekts.

Hinweise und Mogliche Fehler

1. FUr Abschlussarbeiten und studentischen Projekte:

1. Da diese haufig mehr als 100 MB hochladen, sollten Sie nicht
https://git.mexle.org/...

nutzen, sondern:

http://git.mexle.te.hs-heilbronn.de/....

2. In diesem Fall mUssen Sie im Hochschulnetz befinden (z.B. per eduVPN).

3. Fragen Sie bei mir (Tim Fischer) nach, welches Git Repository fur Sie das passende ist.

MEXLE Wiki - https://wiki.mexle.org/
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2. fatal: detected dubious ownership in repository at [..] is on a
filesystem that does not record ownership
Das Problem ist, das der Ordner auf einem Laufwerk liegt, welches keine Benutzerzuordnung
erlaubt (z.B. ein USB-Stick) .
Die Losung wird gleich mitgeliefert:
1. Rechtsklick im Explorer auf den entsprechenden Ordner (z.B. 24WS) » Open Git Bash
here » Es dffnet sich eine Text-Konsole
2. Flgen Sie Folgendes ein git config --global --add safe.directory
D:/GitLab/elektronik/25WS (andern Sie ggf. elektronik in mikrocontroller
und das Semester) und bestatigen Sie mit Return
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